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J Introduction

= Many thanks to the OHSUG for this
opportunity to present this tutorial.

= Many thanks to the OHSUG Planning and
Committee after Planning for their infinite
patience in receiving and expeditious review
of this presentation

= Many thanks to everyone who participated in
the development of presentation.
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Siebel Clinical CTMS
J Tips and Tricks

Agenda

= Siebel Introduction

= General Siebel Navigation
= Other Useful Navigation
= Common Configurations
= Siebel Architecture
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J Siebel Clinical CTMS Interface

Interface

= Consistent in all par

s of the application

= The different processes are carried out by
creating new records, editing existing
records (including status changes) and
triggering automated workflows.

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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J Siebel Clinical CTMS Interface

#Z) Siebel Clinical - Microsoft Internet Explorer

J File Edit Wew Favorites Tools Help

Q- © RGN LPke 2=2RRF Jd 03

J Address I@ http: {localhost: 8080 /start.swe

Query To

Saved Queries:

/;uq Home Contacts |___| Accounts E Calendar | Protocols | Regions | Site Management ';f Payments | Site Visits | Document Tracking | Subjects

Home

Welcome Back Cathy Sanders! My Calendar
Today is Tuesday, February 10, 2009. Y lIl EI EI
Date: Feb [+| 10 [+| 2009 |+ Go

Tuesday 2/10/2009

Your average Customer Satisfaction Score on your last 10 Service Reguests was 90%.
Your goal is 35%. Well done!

My Activities = X
09:00
New Type Description Prioriby Activiby
Procedur Past Medical Histol +
h 3 rocedure ast Medical History 2 10:00
Procedure Physical Exam
Procedure CBC 11:00
Task Obtain Informed Cor 3-Medium
Procedure Peripheral blood sme 12:00
Procedure Reticularcyte count -
Procedure Iron study j 13:00
My Objectives - X 14:00
15:00
16:00
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J Siebel Clinical CTMS Interface

Home Page Components

= The Home Page for each responsibility can
be customized.

= Elements can be customized by each user
by clicking Edit Layout.

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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J Siebel Clinical CTMS Interface

Fle Edit View MNavigate Query Tools Help

E-; |__ il J ] J # 4 & J & |§] Saved Queries: E| |
‘?uq Home Contacts |___| Accounts g Calendar E Calendar - All Employees | Activities | Site Management | Record Of Initiation | Alerts | Supplies Management
Home
Edit Layout
Menuw | Done |  DefaultLayout
iy o - -
[ My Rt § (=]
My Stocks - s
My Objectives = 4 vy X
Programs = A v Y
My Protocols - a v
My Sites - A v
My Sales Orders = a4 v
My Service Orders = A v Y
My Agreements = A v Y
My Analytics =4 v

7 ™ 14
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J Siebel Clinical CTMS Interface

Screen Tabs and View Tabs
= Tabs vary by user responsibility

= Add New screen tab by Site Map (Global
Icon)

s Most screens have one or more view tabs
on the lower section(s).

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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J Siebel Clinical CTMS Interface

October 2010

Fie Edit View Navigate Query Tools Help

=P an i A E 7 &
BEé| & H4dd|aE
Protocol:
3 Home |[3z| Contacts |~
My Protocols E| Menu = Query Query Results
Protocol # Title Status Product
> KC2 KC2 Planned KCProduct-1-Compount
KC-INY-1 KC2 Flanned KCProduct-1-Compount
Menu Query Query Results
# Planned Sites:™ 6 & # Planned Subjects:™ 24 [
Last Subject OFf Study: H Last Site Terminated: H

= Cmemmmemds 1 =l = Cmeallads A =l

First Site Initiated;

Subj Presentation;

Fimbmbmmm | mmlen

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited

Regions Required
v
v
B  First Subject Enrolled; 5/8/2009

Trm=mu CAMKATRI

&

&

# Planned Sites # Planned Subjec

Saved Queries:

Accounts E Calendar E Calendar - All Employees | Activities | Site Management | Record Of Initiation | Alerts | Supplies Management | Protocols

Protocol List | Charts

# Enrolled Team

24 10 SADMIN
24 0 SADMIN
SaweCT ]

1-20f2 ||

lof2
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J Siebel Clinical CTMS Interface

Access

= Several screens and views have an access control
mechanism to allow only certain data records to
be displayed.

= [ he usual division is user > team > all. Some
users may use all three, and some will be
restricted.

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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Siebel Clinical CTMS Interface

October 2010

Fle Edit View Navigate Query Tools Help

5Lo/L nadBd

Account:

Frequently Viewed Accounts

My Accounts
My Accounts

All Accounts
All Accounts

Recent Records

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited

iHelp

Add

Account:®

Site:

Add & Go

Saved Queries: v

J\nq Home ||fiz| Contacts |__‘ Accounts E Calendar E Calendar - All Employees | Activities | Site Management | Record Of Initiation | Alerts | Supplies Management | Protocols

Accounts Home | Accounts List | Charts | Global Accounts Hierarchy List | Global Accounts Administration | Account Management | Accounts Administration | Account D88 Explorer | Service Account Explorer | Billng Account Explorer

EditLz
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J Siebel Clinical CTMS Interface

Accounts

= An account is any entity that does business
with your company.

= The Account record contains all the contact
information, and can also contain other
entities.

= An account can be the child of another
account.

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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Siebel Clinical CTMS Interface

File Edit View Mavigate Query Tools Help

:g;, :E| ] J 2 J # 4 E J = @l Saved Queries: All Accounts v
Account:
Juq Home |@ Contacts | [~ | Accounts H Calendar H Calendar - All Employees | Activities | Site Management | Record Of Initiation | Alerts | Supplies Management | Protocols
Accounts Home | Accounts List | Charts | Global Accounts Hierarchy List | Global Accounts Administration | Account Management | Accounts Administration | Account DB Explorer | Service Account Explorer | Biling Account Explorer
Menu Mew | Delete || Query Schedule 1-10of 11+
Name Location Parent Main Phone # URL Status Account Type  Registration # Account Team Currency Date  Current
Clone 11 Madison Active Research Clinic  1-H93G SADMIN
DEVIISER.2 DEVUSER,_2 Active IRB-Local 55 SADMIN 11/25/2010 v
Dev Account 55 Paris, TX Active Customer 11758 SADMIN
M1 Imp 10 Pune (873) 125-5862 Active Hospital 1234 SADMIN
M1Imp 11 Pune (873) 125-5862 Active Hospital 1234 SADMIN
M1Imp 12 Pune (873) 125-5862 Active Hospital 1234 SADMIN
M1Imp 2 Pune (515 301-1000 x3 Active Hospital 1234 SADMIN
Mew Accountl Kansas City, MO Pine Apple Club Active Hospital 1-1FP1] SADMIN
> RMAcct 1 LodiMJ (973) 555-6666 Active Research Clinic 1-GTCR SADMIN
RM Acct 2 Active Site Metwork FGHH SADMIN
4 gof1i+ b |
Menu = Mew  Delete  Query Mew Call
Account:® RM Acct 1 Location: LodiMJ Phone = (373) 555-6666 Type:® Research Clinic v
Address: [+ Parent: i Currency Date: H
City: State: hd Status: Active hd Current: [~
Zip Code; Country: - Team: SADMIN [ Registration =1 1-GTOR

"
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J Siebel Clinical CTMS Interface

Contacts

= A contact is any person that does business
with your company.

s Contacts can be affiliated to Accounts.

s Account affiliations can have start and end
dates.

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited 14
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J Contacts

View Mavigabe OQuey Took Hep
bL®/| | HHdEH |5 E
Contact:
o Home |[HE Contacts Accomnts |:_§' Calendar | Pratocok | Regions | S Hanagement | Payments | Site Visits | Docunsent Tracking | Subj

Comtacts Home | Contacts List | Consumess List | Manager™s Explorer | Contsct Administraton

Frequenthy ‘Wiewed Contacts = ¥  iHelp
Hy Coatacts
by Comtmrts
o Teer
Top Teer Contacts Lparch
Al Contacts Lt Mames |II
Al Corincis
'=ﬂ-1-‘.a-'r\-e:[
Hy Persgaal Conlacts )
Qe Lk bo Penpanal Corvinct .-.c-c:u.nl:l
oy |
Stabe: -
Recent Records -y | =
Ceurity: | -]
L]
Audd
Y, Las Mame;® |
Fr:'.Hnm-c:"[
Tlﬂr:l

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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J General CTMS Navigation

October 2010

= View Tabs

= Parent Detail Views
= Drill Downs

= Site Map

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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J Other Useful Navigation

= Keyboard Shortcuts
« CTRL + S (Save Record)
= CTRL + B (Copy Record)
« CTRL + U (Undo Record)
= Stepping off a record automatically saves the record
= Merge records
= Export to Excel
= Columns displayed
= User Preferences
= Start up View

= Change password

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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J Other Useful Navigation

October 2010

= EXxecute queries
= Save queries

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited

18



OHSUG 2010 San Antonio: CTMS Tips and Tricks Tutorial Session October 2010

J Keyboard Shortcuts

Data Management Keyboard Shortcuts
Table 21 lists the keyboard shortcuts wou can use when performing data management tasks.

Table 21. Data Management Keyboard Shortcuts

Action Basic Mode Extended Mode Context
MNew record CTRL+ALT+M CTRL+M List, form
Mew record using Quick Fill template CTRL+K Form
Mew record using last used Quick Fill template CTRL+] Form
Lpply Quick Fill template to record CTRL+O Form
Copy recaord CTRL+ALT+C CTRL+B Record
Sawve record CTRL+SHIFT+S CTRL+S List, form
Delete record CTRL+ALTHD CTRL+D Record
Undo record CTRL+ALT+HU CTRL+U Record

-ar- -ar-

ESC ESC
Selaect all CTRL+ALT+A CTRL+A List
Invoke selection dialog box CTRL+ALT+P F2 or DOWMN ARROW Field

Open the calendar control
Open the calculator control

Open a drop-down list

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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J Keyboard Shortcuts

October 2010

Record Mavigation Keyboard Shortcuts

Table 22 lists the kevboard =shortcuts vou can use to navigate to records in the application.

Table 22. Record Mawvigation Keyboard Shortcuts

Action

Drill down into record

Go to previous record

Go to next record

Go to previous record set
Go to next record =set

Go to first record

Go to last record

Query Managemenit

Basic Mode Extended Mode

CTRL+SHIFT+5FACE

({Cur=zor focus must be on the hyperlinked field.)

CTRL+SHIFTH+, CTRL+UFP ARROW
CTRL+SHIFT+. CTRL+DOWMN ARROW
CTRL+ALTH, ALT+UFP ARROW
CTRL+ALT+. ALT+DOWN ARRCW
CTRL+ALT+F ALT+F

CTRL+ALT+L ALT+L

Keyboard Shortcuts

Table 23 lists the keyboard shortcuts vou can use to work with gqueries.

Table 23. Query Management Keyboard Shortcuts

Action

Mew query

Execute query

Refine query

Basic Mode Extended Mode

CTRL+ALT+Q ALT+0Q

CTRL+ALTH+ENTER ALT+ENTER

CTRL+ALT+R ALT+R

Sawve query with different name CTREL+ALT+S ALT+5S

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited

List, form

List, form

List, form

List, form

Context

List, form

List, form

List, form

List, form
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J Keyboard Shortcuts

General Navigation Keyboard Shortcuts
Table 24 lists the keyboard shortcuts you can use to navigate in the application.

Table 24. General Navigation Keyboard Shortcuts

Action Basic Mode Context

Go to Site Map CTRL+SHIFT+4& Application
Go to application-lewel menu CTRL+ALTHM Application
Go back AL THLEFT ARROW Application
Go forward AL T+RIGHT ARROW Application
Go to screen tabs CTRL+SHIFT+T Application
Go to view tabs CTRL+ALT+T Application
Open menu button pop-up on list or form CTRL+SHIFT+M List, form

Go to next list or form CTRL+SHIFTH+] Application
Go to prewvious list or form CTRL+SHIFT+[ Application
Open Search Center CTRL+SHIFT+F Application
Open iHelp CTRL+SHIFT+E Application
Open Tasks CTRL+SHIFT+Y Application

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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) Identifying Views in CTMS

= In the current view click Help > About View
= About View will display:

= Screen

= View

= Business Object

= Applet

= Business Components

(f http://stools/?SWECmd =ShowPopupFrames&SWEDIC =1&SWEU=/start.sw...

Screen: Accounts Screen
Yiew: Account List View
Business Object: Account

Business Components: BusComp[0]: Account; BusComp[1]: Account;

Applets: Applet[0]: SIS Account List Applet; Applet[1]: SIS Account Entry Applet;

OK

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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J Common Configuration

= Alerts
= Customizable Criteria (ie. Trip Reports,
Documents, Financials)

= Integrate with Email (SMTP)
= Calendar

= Configuration — Adapt Siebel Clinical to your
business process

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited 23
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October 2010

J Siebel Architecture Overview

External Internal Mobile Web
Web Clients Web Clients Clients
Firewsll Internet Intranet
o~ Waeb Server Load Balancing
External Weab gieb?: Re.mottie
Applications Servers ynchronization
Firewall
k ™y
T
S
External
Data Siebel
\__|__-f‘ Servers
Siebel
EIM _H'| Ty M
‘l-..__‘___.__,.f‘
~1 Siebel
Siebel J[ Database
Tools — —
= = Siebel
Siebel Siebel Gateway
File i i ceners | Name
System Siebel Siebel Siebel Siebel Server
Configurator  Communications  Workflow EAl
Server

Siebel Enterprise Server

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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Using 10g Grid Control with Oracle Application
Management Pack for Monitoring Siebel CRM

Mew Siebel-Specific Targets

Several new targets, as discussed in Table 1, have been added to Enterprise hanager in order to facilitate the management of Siebel CRM applications. These targets
moadel the entities within a Siebel ervironment sa that they can be managed within Enterprize Manager.

bost of these targets have direct one-to-one mapping with their counterparts in Siebel. Some are created to facilitate specific management capabilities within Enterprize

banager.

Table 1 Siebel-Specific Targets

Enterprise Manager
Target

Siebel Enterprize

Siebel Server

Siebel Component Group
Siebel Component

Siebel Reguired
Component Group

Siebel Functional
Component Group

Siebel Database
Repositary

Siebel Gateway Sener

Siebel Application Senice
(HIy

Siebel Application Serice
(=0

Siebel Entity

Siebel Enterprize
Siebel Application Server
Siebel Component Group

Siebel Component

Siebel Database

Siebel Gateway Sener

Excerpted from
Oracle® Application Management Pack for Siebel Getting
Started Guide

Purpose

Representation of Siebel enterprise providing access to metrics and associated Siebel
SENErs,

Representation of Siebel server providing access to related metrics and configuration
infarmation.

Representation of Siebel component group providing access to metrics and associated Siebel
components.

Representation of Siebel component providing access to component metrics and configuration
information.

Representation of all the Siebel components providing mandatory functionality for the proper
function of a Siebel server,

Representation of all the Siebel cormponents providing functionality that may be used by
multiple components (for example, Workflow).

Representation of Siebel database providing access to Siebel business metrics.

Representation of Siebel gateway server.

Employee Facing Siebel Applications (high  Aggregated Sernice providing information about all the Siebel high interactivity applications.

interactivity)

Customer Facing Siebel Applications

istandard interactivity)

Aggregated Serdce, providing information about all the Siebel standard interactivity
applications.

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited 25
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pes of Logging available in Siebel

=
CYinicaI: Application Object Manager

October 2010

Table 16. Common Event Types for Application Object Manager Diagnostics

Event Type
Mame

Event to track the
flow of a message

Object Manager
Session
Information

Event Context

Cbject Manager
Data CObject Log

Object Manager
Log

Object Manager
Business
Component Log

Object Manager
Business Service
Log

Main Thread Events

Event Type Alias

MessageFlow

ObjMgrsessionInfo

EventContext

ObjMgrDatatbjlog

CbiMgrlog

CbiMgrBusComplog

ObjMgrBusServicelog

MainThread

Log Level
Setting

4

Description

Captures messages exchanged between the Application Object Manager (A0M) and Siebel Web Server
Extension (SWSE).

Captures User Session login, logout, and timeout inforrmation.

Captures applet and method executed, view names, and screen names that the user navigates to,

Captures username and IP address when the session completes,

Captures data manager object tracking; that is, the creation, use, and deletion of database connections,
search specifications, sort specifications, and cursors,

Captures general A0M events: load license, open SRF, errors, and so on.

Captures Business Component-related events: create and delete,

Captures Business Service-related events: create, delete, methods invoked, and so an.

Captures task counter, task creates, and task exits {in main Multithreaded Server log).

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited 26
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TY_pc_es of Logging available in Siebel
Clinical: Application Object Manager

(@)

= Excerpted from Siebel Systems Monitoring and Diagnostics Guide, previous, current, next

slides

Taslk Related TaslkEvents 4 Captures tasl creation, context, session timeout, and close info.

Ewvents

SQL Parse and SQLParseAndExecute 4 Captures the SQL insert, update, and delete statements processed by the database connector. It includes

Execute the SQL staternent and bind variables, The content is similar to the ObiMgrsgllog event; however, the
select statermnent is not captured by the SQLParseAndExecute event.

Object Manager ObiMarsgllog 4 Captures the SQL select, insert, update, and delete staterments processed by the A0M data object layer,

S0L Log Includes the SQL statemnent and bind variables, It also captures the prepare, execute, and fetch time for
the SQL cursor,

5 Captures internal and customer-defined search and sort specifications, the joins processed for queries,
as well as a call stack of the operation performed. Setting this event to log level 5 incurs a significant
petrformance impact because a callstaclk is generated. Only set this event to log level 5 in consultation
with Siebel Technizal Support,

S0L Profiling SQLProfiling 4 Captures SQL Profiling information. Helps aid in the diagnosis of a poorly performing component,

SOQL Sumrnary SQLSummary 4 Captures SQL prepare, fetch, and execute times. Provides detailed information regarding the execution
of a SQL statement,

S0L Slow Query SQLSlowQuery 4 Captures SQL Performance— lists ten slowest performing queries,

Security Adapter Sechdptlog 5 Captures security adaptor tracing information to the A0M log file.

Log

Security Manager SecMarLog 5 Captures security manager tracing information to the 40M log file.

Log

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited L/
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Types of Logging available in
J Siebel Clinical

= Log Levels are 1=Most Severe to 6=Informational messages

Components |laElEL= G

Menu Query Dizable 1-10f1
| | | | [=]

Component Alias Component Group Enable State

» Server Request Broker SRBroker Sy=tem '

Each Component in the Siebel
Architecture can have several Event
Types with different Logging Levels

AU Parameters

[ Menu + [ g-17of76+ | A

Component Alias Event Type Log Level Description
SHBroker Error Condition 1 Triggered upon reaching an unhandled error or exception i
SRBroker General Events 1 General event point logging il
SRBroker Param Encryption 1 Param encryption values in the scr layer

> SRBroker Performance Event 2 Event for Performance Measurements J
SRBroker SHM record Synchronize 1 Triggered during the SRW =ynchronize from gateway to the databaze.
SRBroker Component Tracing 1 A trace condition was met (uzed from LogTrace onby)
SRBroker Tazk Configuration 1 Configuration of Server Tazk
SRBroker Tazk Configuration at exit 1 Configuration of Server Tazk at exit

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited 28
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J Troubleshooting CTMS Issues

- Errors resulting from configuration problems
in the Repository.

- SQL Execution errors and tracing on the
Dedicated Client.

- SQL Execution errors and tracing on the
server for Thin Client.

- Running the Siebel Client in debug mode

29
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) Configuration Troubleshooting

= Validate configuration of
Repository Objects before
compiling SRF:

= In Siebel Tools, select
object(s) of any type, right
click, Validate.

= Set output log filename
and path.

= Click Options and choose
rules to enforce, or
“Enforce All”.

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited

validate
—Ero
Start I
Severity Rl Obiject Diescripti |
eeeee |Rue | jec | escription ] Cancel
Dptiong...
Lietail
Go Tio
Lo fil
IE:\swebe\\tnols\\og\vahdahon.Iod

¥Yalidation Options

everi ule | Object | Description | Enforce | :l
1 All Irvalid Object reference Yes |
(=] 2 Appl.. Mo bwo Appl tW’ b Ted mpl te ltems in an Ap.. Yes
=] 3 Wiew aFieldinthe Bu.. Yes
=] 4 Tres b must be th ‘es
=] 4] Wiew Applet basedon aB...  “Yes
) [ Wiew If Wizibility Applet iz spemfled then Vizibility &...  Yes
(=] 7 Wiew If Wizibility Applet Type iz specifi d th n Wiz h o ez
(] 3 Screen Al Views bazed on the same Business Objact...  Yes
=] 10 Wiew If a Thread Applet is specified, the Thread Fi... ‘es
9 1 Wiew If a Thread Field is specified, the Thread Appl... “es LI
5 Enforce Ig ] tanoean |
Detail
r— Tirne: filter
Only walidate objects changed since:
™| Last walidated: ™ Custom: |1D.-"1 3/2008 j I Slaaz i |
—Action
o Do not report warmings - Abort walidation after l— Errors
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SQL Query Troubleshooting -
J Dedicated/Remote Client

Configuration problems with Repository and/or Database
objects can cause SQL errors in the application:

= Edit Shortcut Properties for Siebel Clinical.

= Use the /s command line switch followed by a path and
filename for output to specify a SQL trace file which wiill
help identify the query that is causing a problem.

= When an error occurs, open the output file and the last
query logged should be the culprit. By analyzing the tables
involved, in the context of the screen/view/business object
where the error occurred, you should be able to identify
the problem Business Component.

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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SQL Query Troubleshooting -
J Dedicated/Remote Client

= Sometimes running the
SQL statement with a
third party SQL client
(like Toad) can help
identify a problem if it
is with the physical DB
object layer.

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited

Siebel Clinical - ENU Properties

Genera | Shartcut |En:nm|:natiI:|iIit_l,I| Securit_l,ll
.‘, Siebel Chrizal - EMLI
Ed
T arget tupe: Application

T arget location: BIM

Target; I"-.eclinical.cfg /5 "c\sisbelclient\tempiirace. |

Start in: IE:"ssieI:ueI"scIient'xI:uin

Shaortzut kew: INu:une

Bur: I Mormal window j

Comment; I

Eind Target... | Change lcon... Advance d.. |
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SQL Query Troubleshooting:
J Server Component (Thin/Web Client)

To trace the SQL execution and event handling of
server components, you need to set certain flags
within the Component’s parameters:

= Navigate to the Administration — Server
Configuration screen, Server Component
Parameters view, and query for the eClinical
Object Manager component on the correct
server(s).

= Click the “Hidden” button on the Component
Parameters applet and set the SQL Trace Flags
parameter to /.

BMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited
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SQL Query Troubleshooting:
J Server Component (Thin/Web Client)

= The log file for the component task, including the
trace of executed SQL, can be found at the
following path:

= /<siebelroot>/siebsrvr/enterprises/<enterprisena
me>/<siebelservername>/log

= (Don't forget to turn the trace flags back to 0
when you are finished as tracing produces large
output files.)
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Set SQL Trace on Siebel
J Thin/Web Client

October 2010

2 | H J &% _}3 v E J G| Saved Queries: v] & ¢
Server Component Parameter:
7 \q Home \[Q j Contacts ﬁ.\ | Accounts @ Calendar “ Projects | Activities | Organizations | Administration - Server Configuration
| | |
Enterprise Explorer | Enterprises | Servers | Job Templates
|
Components ﬁ Parameters [ Events
Menu v Query Manual Start  Query Results 1-10oft E]
Component Alias Component Group
> |eClinical Object Manager (ENU)  eClinicalObjMar_enu LifeSciences
== Parameters
Component Parameters | Advanced SQL Trace Flags 1of 1
Parameter Yalue Yalue on Restart Default Yalue Menu ¥ Query
>|5QL Trace Flags 7 7 7
Q 2 Alias: SQLFlags Effective

©2010 DBMS Consulting, Inc. Unauthorized Duplication is Strictly Prohibited

Subsystem: Event Logging
Data Type: Integer
Override Level: Component level set

Fixed: [~

Description: Flags for tracing of SQL statements %

Immediately: [#

At Next Task: [~

At Component Re-Start: [~
At Server Re-Start: [~

Require Reconfiguration: [~

=
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Running the Siebel Client In
) Debug Mode

= For the purposes of debugging Siebel eScript or
Siebel VB script, you can run a client session in
debug mode and set breakpoints in the script(s).

= In Siebel Tools, select View, Options, and edit the
information in the Debug tab. Make sure to
include the /h switch in the command line
“Arguments” (you may also include /s and specify
a SQL trace output file).
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Siebel Tools => View => Options
=> Debug Tab

Development Tools Options B3

General | LanguageSettings | CheckIn/Out | ListViews | Sciipting
“Web Template Editor Debug I Visualization I Object Explorer I Database

— Run-time start up information

Executable: d:\siaB0hclient34binksiebel. exe
CFG file: [D:\siaB0\client3\BIN\ENUMeclinical_je.cf .. |
EBrowser: lC: “Program Files\Intemet Explorer\|EXPL _]

Working directory: |d:\sia80\client3\bin

Arguments: ]a’h /s "C:\Documents and Settings'_essigj

I~ Prompt for this information each time

[V Show Workflow Primary Business Component Data

— Login information

User name: liessig
Password: l*"""""
Data source: l ServerDataSrc _:_l

| oK I Cancel
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Running the Siebel Client In

) Debug Mode (2)

= To set a breakpoint, right click the left
margin of the line and select Toggle
Breakpoint.

= Start the client in debug mode by pressing
F5, or select Debug, Start, from the
menubar.

= When the breakpoint is reached the client
will halt and Siebel Tools will now allow you
to step through the script with familiar
commands like F8, and resume with F5.

.
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) Conclusion

= Ability to understand basic keyboard shortcuts and CTMS
customization can benefit your organization in:
= Business efficiency
=« User performance
= Reduce time and costs
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_ ) Biographies

Kish Cachola, DBMS Consulting, Inc.

= Kish Cachola is an  Oracle Health Sciences
functional specialist for DBMS Consulting. He has
over 8 years experience in clinical trials and data
management working for CROs, Biotech and
Pharmaceutical.

Jason Essig, Senior Siebel Architecture Expert, DBMS
Consulting, Inc.

= Jason is a Senior Siebel Architecture Expert for
DBMS Consulting, with 12 years of Siebel
architecture, design, and configuration experience.
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J Question and Answers

Jason Essig
jessig@clinicalserver.com
+1-917-846-7683

Kish Cachola
kish.cachola@clinicalserver.com
+1-973-477-7855
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